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 16 Work in Word 
  More Efficiently

In this chapter, you will learn how to
✔ Work with styles and templates.
✔ Change default program options.
✔ Customize the ribbon.
✔ Customize the Quick Access Toolbar.

If you use Microsoft Word 2010 only occasionally, you might be perfectly happy creating 
new documents with the wide range of tools we have already discussed in this book. And 
you might be comfortable with the default working environment options and behind-the-
scenes settings. However, if you create a lot of documents of various types, you might find 
yourself wishing that you could streamline the document development process or change 
aspects of the program to make it more suitable for the kinds of documents you create.

In this chapter, you’ll explore styles and templates, which can greatly enhance document 
development efficiency. You’ll also take a tour of the pages of the Word Options dialog 
box to understand the ways in which you can customize the program. Then you’ll manipu-
late the ribbon and the Quick Access Toolbar to put the tools you need for your daily 
work at your fingertips.

Practice Files Before you can complete the exercises in this chapter, you need to copy 
the book’s practice files to your computer. The practice files you’ll use to complete the 
exercises in this chapter are in the Chapter16 practice file folder. A complete list of 
practice files is provided in “Using the Practice Files” at the beginning of this book.
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Working with Styles and Templates
When you want to quickly create an effective, visually attractive document, you can take 
advantage of your previous work or even the work of other people by saving an existing 
document with a new name and then customizing it to suit the current purpose. However, 
if you frequently create the same type of document, such as a monthly or quarterly report, 
one of the most efficient ways to generate the document is to base it on a template that 
already contains the text, character and paragraph styles, page formatting, and graphic 
elements that you generally use in that type of document.

When it comes to making your work in Word more efficient, styles and templates are 
among the most powerful tools available to you. Entire books have been written about 
them; this discussion can only scratch the surface. We’ll talk about templates first; then 
we’ll discuss styles.

Templates
Although you might not have realized it, all documents are based on a template. New 
blank documents are based on the built-in Normal template, which defines paragraph 
styles for regular text paragraphs, a title, and different levels of headings. It also defines 
a few character styles that you can use to change the look of selected text. These styles 
appear in the Quick Styles gallery on the Home tab, and you can apply these Quick 
Styles to format the text in the document.

See Also For information about applying Quick Styles, see “Quickly Formatting Text” in 
Chapter 3, “Change the Look of Text.”

In addition to the Normal template, Word 2010 comes with a variety of templates for a 
variety of types of documents. To create a document based on one of these templates, 
you start by displaying the New page in the Backstage view. At the top of the New page 
are icons for templates or categories of templates that were installed with Word on your 
computer. The Office.com Templates area lists categories of templates that are available 
for downloading from the Office.com Web site.

Tip If the designation (Compatibility Mode) appears in the title bar when you create a document 
based on a template, it indicates that the template was created in an earlier version of Word. 
Usually this will have no effect on your use of the template, but bear in mind that sometimes 
compatibility can have an impact on functionality.



The New page of the Backstage view.

In general, templates can contain the following:

● Formatting Most templates contain formatting information, which in addition to 
styles can include page layout settings, backgrounds, themes, and other types of 
formatting. A template that contains only formatting defines the look of the docu-
ment, and you add your own content.

● Text Templates can also contain text that you customize for your own purposes. 
For example, if you base a new document on an agenda template from Office.com, 
the text of the agenda is already in place, and all you have to do is customize it. 
Sometimes, a document based on a template displays formatted text placeholders 
surrounded by square brackets—for example, [Company Name]—instead of actual 
text. You replace a placeholder with your own text by clicking it and then typing 
the replacement. If you don’t need a placeholder, you simply delete it.

● Graphics, tables, charts, and diagrams Templates can contain ready-made graphic 
elements, either for use as is or as placeholders for elements tailored to the specific 
document.
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● Building blocks Some templates make custom building blocks, such as headers and 
footers or a cover page, available for use with a particular type of document. They 
might also include AutoText, such as contact information or standard copyright or 
privacy paragraphs.

See Also For information about creating building blocks, see "Inserting Building Blocks” 
in Chapter 5, ”Add Simple Graphic Elements.”

● Macros Sophisticated templates contain macros that allow users to perform 
processes with the click of a button. The topic of macros is beyond the scope of 
this book; for information, search for macros in Word Help.

Tip Word 2010 template files have one of two file name extensions, depending on their content. 
Those that contain macros have the .dotm file name extension; those that don’t contain macros 
have the .dotx extension.

When you base a new document on a template, that template is said to be attached to 
the document. The styles defined in the attached template appear in the Quick Styles 
gallery so that you can easily apply them to any content you add to the document. 

In addition to attaching a document template, you can load global templates to make 
their contents available to a document. Two global templates are automatically loaded 
by Word—the Normal template and the Building Blocks template—but you can load 
others. For example, your organization might have a Custom Building Blocks template 
containing items that it wants you to use in all documents.

See Also For information about attaching a different template to an existing document and 
about loading global templates, see the sidebar “Switching to a Different Template” later in 
this chapter.

If none of the templates that come with Word or that you download from Office.com 
meets your needs, you can create your own template. If you routinely create the same type 
of document, such as a monthly financial report, you can create the appropriate styles, 
format the document, and then save it as a template on which to base future versions of 
that type of document. You can save your new template with text in it, which is handy 
if you create many documents with only slight variations. Or you can delete the text so 
that a new document based on the template will open as a blank document with the set 
of predefined styles available to apply to whatever content you enter.

You can save a custom template anywhere and then browse to and double-click the file 
name to open a new document based on the template. However, if you save the template 
in your default Templates folder, it will be available when you click My Templates on the 
New page of the Backstage view. 

Tip On a Windows 7 computer, the default Templates folder location is C:\Users\<user name>\
AppData\Roaming\Microsoft\Templates. By default, this folder is hidden.



Styles
Even if you don’t want to create your own templates, it’s useful to know how to create 
and modify styles. When you apply direct character formatting or paragraph formatting, 
you affect only the selected characters or paragraphs. If you change your mind about the 
formatting, you have to change the formatting manually everywhere it is applied. When 
you apply a style to characters or paragraphs, you can change the way those characters 
or paragraphs look simply by changing the style definition. With one change in one place, 
you can completely change the look of the document.

You already know that when you create a blank document, it is based on the Normal 
template. Initially, the Normal template displays only a limited number of styles in the 
Quick Styles gallery, but in fact it contains styles for just about every element you can 
think of. Although they are available, these styles aren’t actually used unless you apply 
the style or add the corresponding element to the document. For example, nine para-
graph styles are available for an index, but none of them is used until you create and 
insert an index in the document. You can access the unused styles and manually apply 
them to characters and paragraphs in two ways:

● Clicking the Styles dialog box launcher displays the Styles task pane. By default, 
the task pane shows only the styles in use in the document. Clicking Options at the 
bottom of the task pane opens the Style Pane Options dialog box.

You can specify which styles should be shown and how.

By selecting All Styles in the Select Styles To Show list and Alphabetical in the Select 
How List Is Sorted list, you can display all the available styles in alphabetical order. 
You can then apply a style from the Styles task pane by clicking it.
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The Styles task pane, as it looks when all the available styles are shown.

Tip Selecting the Show Preview check box below the style list displays the style names 
in the formatting assigned to the style. Pointing to a style displays a ScreenTip with its 
formatting specifications.

● Clicking Apply Styles at the bottom of the Quick Styles gallery opens the Apply 
Styles dialog box. The Style Name box displays the name of the style applied to 
the active paragraph or selected text.



Clicking Reapply reapplies the formatting defined in the style, stripping away any direct 
formatting.

Selecting a different style from the Style Name list applies it to the active paragraph 
or selected text. The Style Name list reflects the display in the Styles task pane; that is, 
if the task pane shows only the styles in use, so does the Style Name list in the Apply 
Styles dialog box.

There are three major types of styles, identified in the Styles task pane by icons:

● Paragraph These styles can include any formatting that can be applied to a para-
graph. They can also include character formatting. Paragraph styles are applied 
to the entire paragraph containing the cursor. In the Styles task pane, they are 
identified by a paragraph mark to the right of their names.

● Character These styles can include any formatting that can be applied to selected 
text. They are applied on top of the character formatting defined for the paragraph 
style. Like direct character formatting, character styles are applied to selected text; 
to apply them to an entire paragraph, you must select it.

● Linked These styles are hybrids. If you click in a paragraph and then apply the 
style, the style is applied to the entire paragraph like a paragraph style. If you  
select text and then apply the style, the style is applied to the selection only.

Tip Two additional style types, Table and List, are reserved for styles for those 
document elements.

The simplest way to customize the look of a document is to modify an existing style in 
one of the following ways:

● Apply the style to a paragraph or selected text, and adjust the formatting so that 
the paragraph or selection looks the way you want it. Then update the style defini-
tion with the new formatting by right-clicking the style in the Quick Styles gallery, 
or by clicking the arrow to the right of the style in the Styles task pane, and then 
clicking Update <style> To Match Selection.
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● Right-click the style in the Quick Styles gallery, and click Modify; or click the arrow 
to the right of the style in the Styles task pane; or display the style name in the Apply 
Styles dialog box and click Modify. Then in the Modify Style dialog box, change the 
settings in the Formatting area to achieve the look you want.

You can adjust the formatting definition of any style by changing the settings  
in this dialog box.

If you modify the existing styles, you can save the new style definitions as a style set. 
(Each new style must have the same name as its corresponding existing style.) Clicking 
the Change Styles button in the Styles group on the Home tab, pointing to Style Set, 
and then clicking Save As Quick Style Set opens the Save Quick Style Set dialog box, 
where you name the set. Without changing the storage location, click Save to save the 
style set in the QuickStyles folder. You can then make the style set accessible to any 
document by selecting it from the Style Set list.



See Also For information about switching style sets, see “Quickly Formatting Text” in 
Chapter 3, “Change the Look of Text.”

If you want to create a style rather than redefine an existing one, you apply the formatting 
you want for the style to a paragraph or selection and then click Save Selection As A New 
Quick Style at the bottom of the Quick Styles gallery to open the Create New Style From 
Formatting dialog box. 

You can see the formatting applied to the selected text in the Paragraph Style Preview box.

If you want to refine the definition of the new style, clicking Modify expands the dialog 
box so that it resembles the Modify Style dialog box. (You can go directly to the expanded 
dialog box by clicking the New Style button at the bottom of the Styles task pane.) There 
you can specify the style name and type and all formatting for the style. If you are building  
on an existing style, you can select that style in the Style Based On list and then specify the 
formatting differences rather than defining the style from scratch. If you are creating  
the style as part of a new template, you can make the style part of the template instead  
of only part of the current document.

After you have created the styles you want, you might want to remove any you don’t 
want from the Quick Styles gallery. Right-click the style in the gallery and click Remove 
From Quick Style Gallery. The styles will still be available in the Styles task pane, and you 
can add them back to the Quick Styles gallery at any time by clicking the arrow to the 
right of the style in the task pane and then clicking Add To Quick Style Gallery. To remove 
a style from the Styles task pane, click the arrow to the right of the style, click Delete or 
Revert, and then click Yes to confirm the deletion. 

Tip You cannot delete a built-in style, but if you have modified it, you can revert it back to its 
original formatting.
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In this exercise, you’ll create a template based on a predefined Word template, and then 
you’ll create a document based on the custom template. You’ll also create a template 
based on a document, modify the template’s styles, and create a style. Finally, you’ll 
create a document based on that template.

SET UP You need the AuthorsTemplate_start document located in your Chapter16 
practice file folder to complete this exercise, but don’t open it yet. Just follow the steps.

 1. Display the New page in the Backstage view, and then under Available 
Templates, click Sample templates.

The center pane displays thumbnails of the installed templates.

 2. Scroll down the Available Templates list, and double-click the Oriel Fax template.

Word opens a new fax cover page document based on the selected template.

The fax cover page has placeholders for the text you need to supply.

 3. On the right side of the page, click the [Type the sender company name] place-
holder, and type Lucerne Publishing or your company name. Then if you want, 
replace the other placeholders in the banner on the right side of the page. Also 
replace the placeholders in the FROM area of the cover page.



 4. On the right side of the page, click Lucerne Publishing or your company name, 
and drag across it to select it. Then display the Quick Styles gallery, and click the 
Strong thumbnail.

 5. Open the Save As dialog box, and in the File name box, type My Fax Template.

 6. Display the Save as type list, and click Word Template.

Tip If you want users who have older versions of Word to be able to use the template, 
click Word 97-2003 Template instead.

 7. At the top of the Navigation pane, click Templates.

Word displays your default Templates folder.

See Also For information about changing default file locations, see “Changing Default 
Program Options” later in this chapter.

 8. Click Save, and then close the template.

 9. Display the New page in the Backstage view, and under Available Templates, click 
My templates.

The New dialog box opens.

The customized template is available in the Personal Templates list.
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Tip If you frequently create your own templates, you might want to organize them 
by storing them in subfolders of the default Templates folder. With the contents 
of the Templates folder displayed in the Save As dialog box, click the New Folder 
button, and name the folder in the usual way. When you click My Templates on 
the New page to create a document based on one of your custom templates, the 
subfolders of the Templates folder will appear as tabs in the New dialog box.

 10. With My Fax Template highlighted and Document selected in the Create New 
area, click OK.

Word opens a new document based on your custom fax cover page template.

The customized template produces fax cover pages with all the information that doesn’t 
change already filled in.

 11. Make any changes you want to the fax cover page document, save it in your Chapter16 
practice file folder with the name My Fax, and then close the document.

 12. Open the AuthorsTemplate_start document from the Chapter16 folder, and save 
it as a template named AuthorsTemplate in your default Templates folder.

 13. Select all the text in the document, and change the font to Tahoma. Change the 
color of About the Authors and Author1 to Purple, Accent 4. Then change 
the size of the first paragraph under the Author1 heading to 12 points.



 14. Click anywhere in the About the Authors heading, and then in the Quick Styles 
gallery, right-click the Title style, and click Update Title to Match Selection.

 15. Repeat step 14 to update the styles assigned to Author1 (h1) and the first 
<paragraph1> (Normal).

All the paragraphs to which the h1 and Normal styles are applied are updated to 
reflect your formatting changes.

Updating a style changes the formatting of any paragraphs to which the style is applied.

 16. Select the last paragraph in the document. Then change the size to 9 pts, and make 
the selection bold, underlined, and purple.

 17. Display the Quick Styles gallery, and below the thumbnails, click Save Selection 
as a New Quick Style.

The Create New Style From Formatting dialog box opens. 

 18. In the Name box, replace Style1 with Copyright, and then click Modify.

The dialog box expands to display options for modifying the new style.
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Because the Style Type setting is Linked, you will be able to apply this style to entire  
paragraphs or selected text.

 19. At the bottom of the expanded dialog box, click New documents based on this 
template, and then click OK.

The new style will be available to other documents.

 20. Display the Quick Styles gallery.

The new style appears as a thumbnail.



The new style in the Quick Styles gallery.

 21. Save and close the template.

 22. Display the New page in the Backstage view, click My templates in the cen-
ter pane, and from the New dialog box, create a document based on the 
AuthorsTemplate template.

Word opens a new document with the template’s title and headline already  
in place.

 23. Replace Author1 with Joyce Cox and Author2 with Joan Lambert.

CLEAN UP Save the document as AuthorsDocument, and then close it.

Tip If you want to change an existing template, you need to open the template file, not a 
document based on the template. Display the Backstage view, and click Open. Then in the 
Open dialog box, set the file type to Word Templates, navigate to your Templates folder, 
and then double-click the template.
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Switching to a Different Template

Although style sets provide a quick and easy way to change the look of an existing 
document, there might be times when you want to attach a different template to 
a document. The simplest way to attach a new template is from the Developer rib-
bon tab, which by default is hidden. To display the Developer tab:

 1. Display the Word Options dialog box, and in the left pane, click Customize Ribbon.

 2. Under Main Tabs in the list on the right, select the Developer check box, and 
click OK.

To attach a new template to an open document:

 1. On the Developer tab, in the Templates group, click Document Template.

The Templates And Add-ins dialog box opens.

The Template page of the Templates And Add-ins dialog box.

 2. In the Document Template area, click Attach.

The Attach Template dialog box opens.

 3. Navigate to the template you want to attach, and double-click its file name.



 4. In the Templates And Add-ins dialog box, select the Automatically Update 
Document Styles check box, and then click OK to attach the new template.

 5. In the Styles group, click the Change Styles button, point to Style Set, and then 
at the bottom of the style set list, click Reset To Quick Styles From <template 
name> Template.

The document changes to reflect the style definitions in the new template.

To load a global template and make it available for use:

 1. Display the Templates And Add-ins dialog box, and in the Global Templates 
And Add-ins area, click Add.

 2. In the Add Template dialog box, navigate to the global template you want to 
load, and double-click its file name.

 3. With the check box adjacent to the template’s name selected, click OK.

You can deactivate the global template by clearing its check box, and you can 
unload it by selecting it in the list and clicking Remove.

To replace all instances of one style with another style (if style names don’t match):

 1. Open the Word Options dialog box, and on the Advanced page, under Editing 
Options, select the Keep Track Of Formatting check box. Then click OK.

 2. Display the Styles task pane, point to a style you want to replace, and click the 
arrow that appears to its right.

A list of actions you can perform with the style appears.

You can select or clear all instances of a particular style.

 3. Click Select All <n> Instance(s). Then in the Styles list, click the new style you 
want to apply.

 4. Repeat steps 3 and 4 for each style that needs to be replaced.

To avoid the style-checking overhead, when you have finished replacing styles, you 
might want to repeat step 1 to clear the Keep Track Of Formatting check box.
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Changing Default Program Options
In earlier chapters, we mentioned that you can change settings in the Word Options 
dialog box to customize the Word environment in various ways. For example, we told 
you how to create AutoCorrect entries, how to adjust the save period for AutoRecover 
information, and how to recheck the spelling and grammar of a document. After you 
work with Word for a while, you might want to refine more settings to tailor the pro-
gram to the way you work. Knowing which settings are where in the Word Options 
dialog box makes the customizing process more efficient.

In this exercise, you’ll open the Word Options dialog box and explore several of the 
available pages.

SET UP You don’t need any practice files to complete this exercise. With a blank 
document open and active, follow the steps.

 1. On the Home tab, in the Font group, point to the Bold button.

Word displays a ScreenTip that includes the button name, its keyboard shortcut, 
and a description of its purpose.

See Also For information about keyboard shortcuts, see “Keyboard Shortcuts” at the 
end of this book.

 2. Display the Backstage view, and click Options.

The Word Options dialog box opens, displaying the General page.

The General page of the Word Options dialog box.



If having the Mini Toolbar appear when you select text is more of a hindrance than 
a help, you can disable that feature by clearing the Show Mini Toolbar On Selection 
check box. Similarly, you can disable the live preview of styles and formatting by 
clearing the Enable Live Preview check box.

 3. Under User Interface options, display the Color scheme list, and click Black.

 4. Display the ScreenTip style list, and click Don’t show feature descriptions in 
ScreenTips.

 5. Under Personalize your copy of Microsoft Office, verify that the User name 
and Initials are correct, or change them to the way you want them to appear.

 6. Click OK to close the Word Options dialog box.

The program window elements are now black and shades of gray.

 7. In the Font group, point to the Bold button.

The ScreenTip now includes only the button name and its keyboard shortcut.

 8. Open the Word Options dialog box, and in the left pane, click Display.

On this page, you can adjust how documents look on the screen and when printed.

The Display page of the Word Options dialog box.
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 9. In the left pane, click Proofing.

This page provides options for adjusting the AutoCorrect settings and for refining 
the spell-checking and grammar-checking processes.

See Also For information about AutoCorrect and checking spelling, see “Correcting 
Spelling and Grammatical Errors” in Chapter 2, “Edit and Proofread Text.”

The Proofing page of the Word Options dialog box.

 10. Display the Save page.

On this page, you can change the default document format; the AutoRecover file save 
rate and location; the default location to which Word saves files you create; and the 
default location for files you check out from document management servers (such as 
Microsoft SharePoint) and drafts of those files saved while you are working offline. 

Tip Although we mention SharePoint in “Co-Authoring Documents” in Chapter 15, 
“Collaborate on Documents,” a discussion of SharePoint is beyond the scope of  
this book.



The Save page of the Word Options dialog box.

The Save page also has options for specifying whether you want the fonts used 
within the current document to be embedded in the document, in the event 
that someone who opens the document doesn’t have those fonts on his or her 
computer.

 11. Under Save documents, display the Save files in this format list.

Notice the many formats in which you can save files. One of these is the Word 97-2003 
Document format that creates .doc files compatible with earlier versions of Word. If 
you have upgraded to Word 2010 but your colleagues are still working in an earlier 
version of the program, you might want to select this option so that they will be 
able to view and work with any document you create.

Tip If you want to save just one document in a format that is compatible with earlier 
versions of the program, you can click Word 97-2003 in the Save As Type list of the 
Save As dialog box.
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 12. Click away from the list to close it, and then display the Language page.

If you create documents for international audiences, you can make additional 
editing languages available on this page. You can also specify the Display, Help, 
and ScreenTip languages.

The Language page of the Word Options dialog box.

 13. Display the Advanced page.

This page includes options related to editing document content; displaying 
documents on-screen; printing, saving, and sharing documents; and a variety  
of other options. Although these options are labeled Advanced, they are the 
ones you’re most likely to want to adjust to suit the way you work. 



The Advanced page of the Word Options dialog box.

 14. Take a few minutes to explore all the options on this page.

In the General area at the bottom of the page are two buttons:

❍ File Locations You click this button to change the default locations of 
various types of files associated with Word and its documents.

❍ Web Options You click this button to adjust settings for converting a 
document to a Web page.

See Also For information about converting a Word document to a Web page, see 
“Creating and Modifying Web Documents” in Chapter 11, “Create Documents for Use 
Outside of Word.”

 Changing Default Program Options  427



428  Chapter 16 Work in Word More Efficiently

 15. Skipping over Customize Ribbon and Quick Access Toolbar, which we discuss in 
later topics in this chapter, click Add-Ins.

This page displays all the active and inactive add-ins and enables you to add and 
remove them.

The Add-Ins page of the Word Options dialog box.

See Also For information about add-ins, see the sidebar “Using Add-ins” at the end of 
this topic.

 16. Display the Trust Center page.

This page provides links to information about privacy and security. It also provides 
access to the Trust Center settings that control the actions Word takes in response 
to documents that are provided by certain people or companies, that are saved in 
certain locations, or that contain ActiveX controls or macros.



The Trust Center page of the Word Options dialog box.

 17. Under Microsoft Word Trust Center, click Trust Center Settings, and then in the 
left pane of the Trust Center dialog box, click Trusted Locations.

On this page, you can specify the locations from which Word will not block content.

The Trusted Locations page of the Trust Center dialog box.
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 18. Explore the other pages of the Trust Center dialog box, and then click Cancel to 
return to the Word Options dialog box.

CLEAN UP Reverse any changes you don’t want to keep before moving on. Then 
close the Word Options dialog box.

Using Add-ins

Add-ins are utilities that add specialized functionality to a program (but aren’t full-
fledged programs themselves). Word includes two primary types of add-ins: COM 
add-ins and Word add-ins. The first type uses the Component Object Model to 
create utilities that extend the functionality of Office programs. The second type 
includes templates that incorporate sophisticated functionality such as macros.

There are several sources of add-ins:

● You can purchase add-ins from third-party vendors—for example, you can 
purchase an add-in that augments the ability to work with numbers in tables.

● You can download free add-ins from the Microsoft Web site or other Web sites.

● When installing a third-party program, you might install an add-in to allow it 
to interface with Microsoft Office 2010 programs. For example, you can install 
an add-in to capture screens from within an Office document.

Important Be careful when downloading add-ins from Web sites other than those you 
trust. Add-ins are executable files that can easily be used to spread viruses and otherwise 
wreak havoc on your computer. For this reason, default settings in the Trust Center 
intervene when you attempt to download or run add-ins.

To use some add-ins, you must first install them on your computer and then load 
them into your computer’s memory, as follows:

 1. At the bottom of the Add-Ins page of the Word Options dialog box, display 
the Manage list, click either COM Add-ins or Word Add-ins, and then click Go.

A dialog box corresponding to the type of add-in you selected opens. For 
example, if you select COM Add-ins in the Manage list, the COM Add-ins 
dialog box opens.



 2. In the dialog box, click Add.

 3. In the Add-In dialog box, navigate to the folder where the add-in you want 
to install is stored, and double-click its name.

The new add-in appears in the list of those that are available for use.

 4. In the list, select the check box of the new add-in, and then click OK.

The add-in is now loaded and available for use in Word.

To unload an add-in, open the Add-Ins dialog box and clear the add-in’s check box 
to remove the add-in from memory but keep its name in the list. To remove the 
add-in from the list entirely, click the add-in name, and then click Remove.

Tip The Templates And Add-Ins dialog box that is displayed when you select Word 
Add-Ins and click Go includes pages that allow you to add XML schemas, expansion 
packs, and cascading style sheets. These topics are beyond the scope of this book. For 
information, search on XML or the particular type of Word add-in in Word Help.

Customizing the Ribbon
Even if Word 2010 is the first version of the program you have ever worked with, you will 
by now be accustomed to working with commands represented as buttons on the ribbon.  
The ribbon was designed to make all the commonly used commands visible, so that 
people could more easily discover the full potential of the program. But many people use 
Word to perform the same set of tasks all the time, and for them, the visibility of buttons 
(or even entire groups of buttons) that they never use is just another form of clutter.

See Also For information about minimizing and expanding the ribbon, see “Customizing the 
Quick Access Toolbar” later in this chapter.

Would you prefer to see fewer commands, not more? Or would you prefer to see more 
specialized groups of commands? Well, you can. Clicking Customize Ribbon in the left 
pane of the Word Options dialog box displays the Customize Ribbon page, which is new 
in Word 2010.

 Customizing the Ribbon  431



432  Chapter 16 Work in Word More Efficiently

The Customize Ribbon page of the Word Options dialog box.

On this page, you can customize the ribbon in the following ways:

● If you rarely use a tab, you can turn it off. 

● If you use the commands in only a few groups on each tab, you can remove the 
groups you don't use. (The group is not removed from the program, just from its tab.)

● You can move a predefined group by removing it from one tab and then adding it 
to another.

● You can duplicate a predefined group by adding it to another tab.

● You can create a custom group on any tab and then add commands to it. (You 
cannot add commands to a predefined group.)

● For the ultimate in customization, you can create a custom tab. For example, you 
might want to do this if you use only a few commands from each tab and you find 
it inefficient to flip between them.



Don't be afraid to experiment with the ribbon to come up with the configuration that best 
suits the way you work. If at any point you find that your new ribbon is harder to work with 
rather than easier, you can always reset everything back to the default configuration.

Tip If you have upgraded from Word 2003 or an earlier version, you might have identified a few 
commands that no longer seem to be available. A few old features have been abandoned, but 
others that people used only rarely have simply been pushed off to one side. If you sorely miss 
one of these sidelined features, you can make it a part of your Word environment by adding it 
to the ribbon. You can find a list of all the commands that do not appear on the ribbon but are 
still available in Word by displaying the Customize Ribbon page of the Word Options dialog box 
and then clicking Commands Not In The Ribbon in the Choose Commands From list.

In this exercise, you’ll turn off tabs, remove groups, create a custom group, and add a 
command to the new group. Then you’ll create a tab and move predefined groups of 
buttons to it. Finally, you’ll reset the ribbon to its default state.

SET UP You need the ProceduresEdited_start document located in your Chapter16 
practice file folder to complete this exercise. Open the ProceduresEdited_start 
document, and save it as ProceduresEdited. Then follow the steps.

 1. Open the Word Options dialog box, and then click Customize Ribbon.

The Customize Ribbon page is displayed.

 2. In the list on the right, clear the check boxes of the Insert, Page Layout, 
References, Mailings, and Review tabs. Then click OK.

The ribbon now displays only the File, Home, and View tabs.

You cannot turn off the File tab.

 3. Redisplay the Customize Ribbon page of the Word Options dialog box, and 
in the right pane, select the Page Layout check box. Then click the plus sign to 
display the groups on this tab.

 4. Above the left pane, display the Choose commands from list, and click Main 
Tabs. Then in the list below, click the plus sign adjacent to Page Layout to display 
the groups that are predefined for this tab.
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 5. In the right list, click the Paragraph group, and then click Remove.

The group is removed from the Page Layout tab on the ribbon (the list on the right), 
but is still available in the list on the left. You can add it back to the Page Layout tab, 
or add it to a different tab, at any time.

 6. In the right pane, click the plus sign adjacent to Home to display its groups, and 
then click the word Home.

 7. Below the right pane, click New Group. When the New Group (Custom) group 
is added to the bottom of the Home group list, click Rename, type Final in the 
Display name box, and click OK. Then click the Move Up button until the Final 
group is at the top of the list.

Because of its location in the list, the new group will appear at the left end of the 
Home tab.

You have created a custom group on the Home tab.

 8. Above the list on the left, display the Choose commands from list, and click File Tab.

The available commands list changes to include only the commands that are available 
in the Backstage view, which you display by clicking the File tab.

 9. In the available commands list, click Inspect Document, and click Add. Then repeat 
this step to add Mark as Final.



The two commands are added to the custom group.

You can add commands to a custom group, but not to a predefined group.

 10. In the list on the right, remove the Font, Paragraph, and Styles groups from the 
Home tab, and remove the Page Background group from the Page Layout tab.

 11. Click the word Home, and then below the list, click New Tab.

A new tab is added to the right pane and is selected for display on the ribbon. It 
has automatically been given one custom group.

 12. Click Remove to remove the custom group.

 13. Click New Tab (Custom), then click Rename. In the Rename dialog box, type 
Formatting in the Display name box, and click OK.

 14. Display Main Tabs in the list on the left, and then expand the Home and Page 
Layout tabs.

 15. With the Formatting (Custom) tab selected in the right pane, add the Font, 
Paragraph, and Styles groups from Home in the left pane, and then add Page 
Background from Page Layout.

The right pane shows the new configuration of the Home, Formatting, and Page 
Layout tabs.
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You have moved groups from the Home and Page Layout tabs to a new Formatting tab.

 16. In the Word Options dialog box, click OK.

The Home tab displays the new Final group.

The custom Home tab.

 17. Click the Formatting tab.

The formatting commands are now collected on the Formatting tab.

The custom Formatting tab.

 18. Display the Customize Ribbon page of the Word Options dialog box. In the lower-
right corner, click Reset, and then click Reset all customizations. Then in the 
message box asking you to confirm that you want to delete all ribbon and Quick 
Access Toolbar customizations, click Yes.



 19. Click OK to close the Word Options dialog box.

The default ribbon configuration is restored.

CLEAN UP Close the ProceduresEdited document.

Customizing the Quick Access Toolbar
By default, the Save, Undo, and Redo buttons appear on the Quick Access Toolbar. If 
you regularly use a few buttons that are scattered on various tabs of the ribbon and you 
don’t want to switch between tabs to access the buttons or crowd your ribbon with a 
custom tab, you might want to add these frequently used buttons to the Quick Access 
Toolbar. They are then always visible in the upper-left corner of the program window.

Clicking Quick Access Toolbar in the left pane of the Word Options dialog box displays 
the page where you specify which commands you want to appear on the toolbar.

The Quick Access Toolbar page of the Word Options dialog box.
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On this page, you can customize the Quick Access Toolbar in the following ways:

● You can define a custom Quick Access Toolbar for all documents, or you can define 
a custom Quick Access Toolbar for a specific document.

● You can add any command from any group of any tab, including contextual tabs, 
to the toolbar.

● You can display a separator between different types of buttons.

● You can move buttons around on the toolbar until they are in the order you want.

● You can reset everything back to the default Quick Access Toolbar configuration.

If you never use more than a few buttons, you can add those buttons to the Quick 
Access Toolbar and then hide the ribbon by double-clicking the active tab or by clicking 
the Minimize The Ribbon button. Only the Quick Access Toolbar and tab names remain 
visible. You can temporarily redisplay the ribbon by clicking the tab you want to view. 
You can permanently redisplay the ribbon by double-clicking any tab or by clicking the 
Expand The Ribbon button.

As you add buttons to the Quick Access Toolbar, it expands to accommodate them. If 
you add many buttons, it might become difficult to view the text in the title bar, or all 
the buttons on the Quick Access Toolbar might not be visible, defeating the purpose of 
adding them. To resolve this problem, you can move the Quick Access Toolbar below the 
ribbon by clicking the Customize Quick Access Toolbar button and then clicking Show 
Below The Ribbon.

In this exercise, you’ll add a couple of buttons to the Quick Access Toolbar for all docu-
ments, and then you’ll test the buttons.

SET UP You need the AgendaSH_start document located in your Chapter16 practice 
file folder to complete this exercise. Open the AgendaSH_start document, and save it 
as AgendaSH. Then follow the steps.

 1. Open the Word Options dialog box, and then click Quick Access Toolbar.

A list of available commands appears on the left, and a list of the commands 
currently displayed on the Quick Access Toolbar appears on the right.

Tip If you want to create a Quick Access Toolbar that is specific to the active document, 
on the right side of the Word Options dialog box, click the arrow at the right end of the 
box below Customize Quick Access Toolbar, and then click For <name of document>. 
Then any command you select will be added to that specific toolbar instead of the 
toolbar for all documents.

 2. At the top of the available commands list on the left, double-click Separator.



 3. Scroll down the available commands list, click the Quick Print command, and then 
click Add.

 4. Repeat step 3 to add the Text Highlight Color command.

The list of commands that will appear on the Quick Access Toolbar now includes the 
items you have added. 

The arrow to the right of the Text Highlight Color command indicates that clicking this button 
on the Quick Access Toolbar will display a menu of options.

 5. Click OK to close the Word Options dialog box.

The Quick Access Toolbar now includes the default Save, Undo, and Repeat buttons 
and the custom Quick Print and Text Highlight Color buttons, separated by a line.

You have added two buttons to the Quick Access Toolbar.

To print a document with the default settings, you no longer have to click the File 
tab to display the Backstage view, click Print in the left pane, and then click the 
Print button.

 6. If you want to test printing from the Quick Access Toolbar, ensure that your printer 
is turned on, and then on the Quick Access Toolbar, click the Quick Print button.

Now let’s see how easy it is to highlight or remove highlighting from text when you 
are working primarily with the commands on a tab other than the Home tab.

 7. Click the Review tab. Then select the first highlighted paragraph, Proof of notice 
of meeting.

 8. On the Quick Access Toolbar, click the Text Highlight Color arrow, and then click 
No Color.

The yellow highlight is removed from the selection. The No Color option becomes 
the default for the Text Highlight Color button.
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 9. Select the next highlighted paragraph, and on the Quick Access Toolbar, click the 
Text Highlight Color button.

The yellow highlight is removed from the selection.

 10. Display the Quick Access Toolbar page of the Word Options dialog box, click 
Reset, and then click Reset only Quick Access Toolbar.

 11. In the Reset Customizations message box, click Yes to return the Quick Access 
Toolbar to its default contents. Then click OK to close the Word Options dialog box.

CLEAN UP Save the AgendaSH document, and then close it.

Key Points
● The Word environment is flexible and can be customized to meet your needs.

● You can create styles and templates to speed up the work of formatting a docu-
ment. Styles and templates ensure that formatting is consistent within a document 
and between documents.

● Most of the settings that control the working environment are gathered on the 
pages of the Word Options dialog box.

● You can customize the ribbon to put precisely the document development tools 
you need at your fingertips.

● You can provide one-click access to any Word 2010 command by adding a button 
for it to the Quick Access Toolbar, either for all documents or for one document.
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